
EDITING VIDEO IN THE MEDIA ARTS CENTER (MAC) LAB 
A QUICK START GUIDE 

 
 
BEFORE YOU START: If you are planning on working with video for more than 
one semester, or are planning to make long projects in a video class, we 
strongly recommend that you invest in a FireWire drive to which all your media 
and project files will be saved.  LaCie or TekServe drives are generally reliable.  
We also advise students who will be using their drives for multiple purposes to 
create a partition specifically for video, which you can do using Mac’s Disk Utility 
(in the Utilities folder under Applications) before you format the drive. Final Cut 
Pro cannot communicate with remote files – including any files stored on your 
server space -- at sufficient speed to work properly, so if you work from the 
server you will experience frequent errors; and if you work from the local hard 
drives you may find yourself competing for drive space, vying for specific 
workstations, or frequently copying and reconnecting media files from one 
machine to another.  A FireWire drive will make your lives easier and can easily 
be reformatted and used for storage or backup of other files if you decide to 
abandon your video ambitions. 
 
 
1.  SETTING UP YOUR FINAL CUT PRO PROJECT:  
SETTINGS, PREFERENCES, SCRATCH DISKS, WINDOWS, KEYBOARD 
 
STEP 1 
When you launch Final Cut for the first time on a machine, or use the File – New 
Project menu command to create a new project, Final Cut will usually prompt you 
to choose an Easy Setup for your project.  This setup will determine most of your 
settings and preferences.  The default setup in the MAC lab is DV NTSC 48khz, 
which will create a project where you can work with footage that is shot on DV, in 
NTSC format, with a 4:3 (TV standard) aspect ratio, and with 48khz sample rate, 
16 bit audio.  Unless you shot your project on a PAL camera or with a 16:9 
(anamorphic or wide-screen) ratio, you will want to use this default setup.  There 
are PAL and 16:9 setups in the Easy Setup pull-down menu, which you can 
select if you shot in those formats.  (Note that if you use the New Project 
command to create a new project and are not prompted to use Easy Setup, your 
project has automatically been configured to match the last existing project, but 
you can access Easy Setup through the Final Cut Pro menu to change the 
setup.)  Once you hit the Setup button and the project is created, create a folder 
named FCP_your_username in the Scratch directory on the local hard drive or 
on your FireWire drive and save your project to the folder.  Remember, Scratch is 
the only directory that you have permission to write to on these workstations, so 
don’t try to save anywhere else or your files may disappear. 
Update: If you use an HDV camera to shoot your project, make sure to use one 
of the HDV Easy Setups, and double-check that all the settings exactly match 



the settings you shot with – HDV cameras can be set to a number of different 
frame rates and aspect ratios. 
 
STEP 2 
Familiarize yourself with the System Settings, User Preferences, and 
Audio/Video Settings.  You can access all of these under the Final Cut Pro 
menu directly to the left of the File menu.  Click through all of the tabs and make 
sure that you know where different settings and preferences are controlled.  
Make sure that your User Preferences are set to 25 levels of undo and that 
auto-save is set to happen at least once every 10 minutes, if not more often. 
VERY IMPORTANT:  Then go into your System Settings, and click on the 
Scratch Disks tab.  You’ll see that Final Cut Pro has automatically set your 
Capture and Render Scratch Disks, your AutoSave vault and your Thumbnail 
cache to your user folder on the remote server.  RESET ALL OF THESE TO 
YOUR FCP FOLDER IN THE LOCAL SCRATCH DIRECTORY OR ON YOUR 
DRIVE.  You absolutely must reset the scratch disks to avoid file errors caused 
by remote communication.  As soon as you reset the scratch disks, FCP will 
create AutoSave, Render and Scratch Disk folders inside your FCP folder, which 
is where all the files you bring into, create and modify in Final Cut will be saved. 
For local Scratch users: If you are working in local Scratch and planning to use 
another workstation for your next editing session, you should copy the entire 
folder to your user folder on the remote server and then copy the entire folder to 
the Scratch directory of the local hard drive on the new workstation when you 
start your next session. (In either case, you should be backing up your FCP 
project files to your server folder and to some external media – CD-RW or 
keychain drive – at the end of every session.)  By keeping the folder intact, you 
preserve the relative relationships of media files (Capture Scratch and Render) 
and project files, which should keep Final Cut from losing track of anything.  If 
when you relaunch the project you get a message that your media and/or render 
files are missing, however, then you can use the File-Reconnect Media 
command to locate them.  In the Reconnect Media dialog box, use the Locate 
option (rather than Search) to find the files manually, and browse through your 
drives until you find the files.  If you have the Matched Names Only box checked, 
the clip with the matched name will be highlighted as soon as you find the correct 
folder.  If you select the Reconnect All Files in Relative Path checkbox, FCP will 
also recognize the other missing media files located in the same folder.  This 
process should relink all your files successfully – you may have to do it several 
times though.  Please bear in mind that your server space does have a size limit, 
so you will run out of space eventually – keep your projects lean and clean. 
For FireWire users: You can avoid everything in the paragraph above if you 
have a FireWire drive, since FCP is configured to communicate with fast FireWire 
drives, so you can just keep your files on the FireWire drive all the time and avoid 
all the copying and reconnecting.  If, however, you experience sluggish FCP 
performance (unusually slow renders or autosaves, for example), then you might 
try copying just your project file to the Scratch directory on the local hard drive 



during your edit session, then copying it back to your FireWire at the end of your 
session. 
 
STEP 3 
Make sure that all necessary windows are visible and aligned on the screen in 
the most efficient way for your workflow.  You should see the Browser, Viewer, 
Canvas, Timeline, Tool Palette and audio Levels monitor.  You can use the 
menu command Window-Arrange to quickly reset all the FCP windows in one of 
several standard configurations.  If you don’t see a Timeline window, that means 
that you have no sequences in (or active in) your project.  Either double click on 
a sequence in your Browser to open up the Timeline window, or create a new 
sequence by using the key command Command-N or the menu command File-
New-New Sequence.  You can change the viewing options for the Timeline (e.g. 
audio waveforms, track height) using the toggle buttons and pop-up menu (which 
becomes visible when your cursor is over the small arrow) at the bottom left of 
the window.  Note that you should generally not let the Browser, Viewer, and 
Canvas windows overlap with each other on the screen, as this can sometimes 
cause dropped frames during playback and output.  Also note that if you need to 
use menu-defined (rather than window-defined) settings other than the default 
Sequence Settings for a new sequence, you MUST set them before creating the 
sequence.  This can be done through the Sequence-Settings menu command. 
 
STEP 4 
The editing process involves a lot of repetition, so editors rely on key commands 
to work more efficiently.  You can become familiar with key commands gradually 
by paying attention to the menus, which list the corresponding key command for 
every menu command that has one.  You can also use the Keyboard Layout 
map under the Tools menu to quickly learn where the commands you use most 
frequently are mapped on your keyboard.  If you unlock the layout tool, you can 
also remap the commands to different keys.  This keyboard layout will be 
customized under the preferences linked to your username, so it won’t affect the 
layout for other users.  Also note that many FCP key commands have right-hand 
and left-hand equivalents.  (Being right-handed, I have memorized the right-
handed versions, so those are the ones indicated in this guide.  The official FCP 
manual should have a list of left-handed versions of the same commands.) 
 
The first key command you will probably want to memorize is for the menu 
command File-Save All.  Final Cut can be buggy, so you should save your work 
frequently, especially before rendering (the time when FCP is most likely to 
crash).  In Final Cut, Save All (Option-Command-S) saves your work throughout 
the project, as opposed to Save, which saves only in the active window.  
 
 
 



2.  BRINGING VIDEO AND MEDIA FILES INTO YOUR PROJECT:  
FILE FORMATS, IMPORTING, DIGITIZING VIDEO WITH LOG & CAPTURE 
 
Before you start: Final Cut Pro is a nonlinear editing system.  This means that 
any media (video, audio, images, or animations) that you want to edit with FCP 
has to be converted from its original state – usually an electronic signal recorded 
on tape – into information that can be read and re-written by FCP’s program.  
The digitizing process performs precisely this conversion, while importing copies 
already-converted media into an FCP project.  Since digitized media has been 
converted by FCP, you will be able to read and re-write it (i.e. view and edit it) 
within FCP until the point where you have manipulated the information so much 
that FCP needs to write a new file to double for the old one – which process is 
called rendering.  Meanwhile, imported media often exists as files whose 
information is not formatted with the same standards (codecs) as the digitized 
files converted by FCP itself.  So FCP usually has to conform the imported files 
to its own particular conversion standards before you can read and re-write them 
within the program.  Hence most imported files need to be rendered before they 
can be viewed or edited, unless they are pre-conformed by the user to FCP 
format. 
Each chunk of media that you bring into FCP does, however, retain its unique 
timecode signature, which assigns each frame of video or digital audio a 
chronological number, so that you can synchronize production and post across 
multiple devices, systems, compression ratios and formats.  (Sound from 
CD/minidisc, still images, and footage from VHS decks or other non-controllable 
devices have timecode generated for them by the program when they are 
brought into FCP.  This artificial timecode allows you to work with the media files 
across multiple sequences and projects, but unlike real timecode, will not enable 
you to re-match a media file to the original media.) 
 
STEP 1 
Once you’ve defined your project settings, any media that you bring into your 
project has to be in a format consistent with those settings.  So if you’re planning 
to digitize from DV tapes, make sure that they are all NTSC, shot in 4:3 ratio, and 
have 48khz audio – unless you defined your project as PAL, 16:9, and 44.1khz.  
(Also make sure you are shooting in SP, not LP – Final Cut will not digitize from a 
tape recorded in LP.)  The same goes for importing video or audio files from the 
web, iTunes, or other sources.  QuickTime (.mov) and AIFF (.aif) are the only file 
formats that Final Cut will accept for imported files, but if those QuickTimes and 
AIFFs have the wrong aspect ratio or audio sample rate, then you will either have 
to render them every time you watch them (lots of time and processor power 
wasted) or you won’t be able to play them at all within the project.  Since 44.1 
khz is the standard sample rate for audio CDs, for example (as well as most 
everything but sound attached to video), you will run into this problem quite often. 
 
Now, this doesn’t really mean that you are radically limited in what kinds of A/V 
material you can bring in to FCP – it just means that you are often better off 



converting the file formats BEFORE you import your video or audio.  In the MAC 
Lab, there are several applications available that can help you with conversion.  
QuickTime Pro offers the simplest solution.  Any file that you can open in 
QuickTime Pro can be converted to the .mov format using the menu command 
File-Export.  You can also use the menu command Window-Show Movie 
Properties to get information about the way your file is encoded and what its 
audio sample rate is, so that you know exactly what settings you need to adjust 
in order to match the file to your project settings.  To change the sample rate of 
an audio file, you can use Peak or ProTools (on the admin station) to adjust the 
setting and Bounce the audio to a new file.  For video formats that QuickTime 
Pro does not accept, you can try the VLC Media Player.  In VLC, you use the 
File-Open Source command to open your file, DVD disc, or streaming video URL, 
then check off the advanced output box and use the Settings dialog box to 
designate a file with an FCP-compatible file format that VLC will stream its output 
to while playing the source.  (See the VLC documentation for more details on this 
process.)  Update: Within the next few weeks, all the machines in the MAC Lab 
should also have copies of Audacity (an audio editing program), ffmpegX (a 
powerful video and audio compression and conversion program) and MPEG 
Streamclip (a demuxing program) installed.  These will all be in the Freeware 
folder under Applications.  If you need to pull some video from a DVD at some 
point during the semester, I recommend installing Cinematize on your own 
computer – this open-source app allows you to choose exactly which minutes of 
video you want to rip from most DVDs. 
 
You can also import still images into Final Cut Pro in a range of formats (JPEG, 
TIFF, PICT).  Layered PSD files will import as alpha channels.  Still images 
import as freeze frames with a default duration of 1:00, unless you change the 
default in your preferences. Again, if your images are not formatted in the same 
aspect ratio as your project, they will have to be rendered to be viewed in the 
Timeline.   
 
The key command for importing is Command-I (for individual files only) and the 
menu command is File-Import, which gives you the option of importing individual 
Files or importing a Folder of files. 
 
STEP 2 
To digitize footage from your DV camera or deck into Final Cut, you have to be 
able to use Device Control to communicate with the camera, and you have to be 
able to read the timecode from the tape in the camera into the Log and Capture 
window.  FCP has to initialize device control as it’s starting up, so if you are 
planning to digitize or output, you should have your camera/deck connected to 
the computer with a FireWire cable, turned on, and in playback/VTR mode 
BEFORE you launch FCP.  If the camera is not connected properly, when you 
start FCP the error message “Unable to locate External Device” will come up.  If 
you need to use the camera during your editing session, then you should check 
your connections and power and hit the Check Again button until FCP recognizes 



the camera and launches.  (Otherwise you can hit Continue and set External 
Video to None.  If you need to connect a camera later in your session, Save All, 
quit, and relaunch FCP with the camera connected and powered on in playback 
mode.) 
Update: Please note that the procedures for digitizing from an HDV camera are 
slightly different.  If you are planning to shoot with an HDV camera, you should 
first read the FCP Help Menu special booklet on HD and Broadcast formats. 
 
To launch Log and Capture, use the key command Command-8 or the menu 
command File-Log and Capture.  If your camera/deck is connected correctly, you 
should be able to preview the video on your tape within the Log and Capture 
window.  Sometimes you will see color bars with the message No Preview 
Available when you first open the window.  In this case you should try to play the 
tape using FCP device control, either with the player control buttons in the L&C 
window or by using the L (Play), K (Pause), and J (Play in Reverse) keys.  Note 
that if you hit the L and J keys 2, 3, or 4 times you can play at 2x, 3x, or 4x 
speed.  If you still can’t preview the video from your camera/deck, you need to 
adjust the capture and/or device control settings in the other tabs of the Log and 
Capture window.  
 
Once you are able to preview the video from your camera/deck in the L&C 
window, click into the Clip Settings tab and make sure that all the settings reflect 
how you want the video and audio on your tape to be digitized into your project.  
Your options include digitizing Video Only, Audio Only, Video with Audio linked 
as a Stereo Pair, and Video with Audio linked as independent Channels 1 + 2.  
You can change these settings on the fly as you log and capture (i.e. you can 
digitize different clips from the same tape with different settings). 
 
STEP 3 
At this point you have four options.   

1) You can log all the clips on your tape without capturing them, and then tell 
Final Cut to batch capture them.  This option works best if you have 
unbroken timecode on your tape.  To log a clip, play through your footage 
(using the L&C window controls or key commands) until you find the point 
where you want the clip to start.  Use the i key to set an in point.  Then 
play through to the point where you want the clip to end, and use the o key 
to set an out point.  Finally, use the Log Clip button in the L&C window or 
the F2 key command to log your clip.  A dialog window will pop up, into 
which you can type a clip name, description and log notes (for example: 
“clipped audio” or “dialogue inaudible”).  Use the tab key to navigate 
through these fields, and then hit return or use the mouse to press the 
button to log your clip.  The clip will appear in the Browser with a red slash 
through its icon, indicating that the media to which it refers is still offline.  
Repeat the process until you have created clips in Final Cut for all the 
footage you want to use from your tape.  Then click into the Browser 
window, use Shift-click to select all the clips from that tape, and use the 



menu command File-Batch Capture to tell Final Cut to digitize all the 
footage for you.  You should wait and watch FCP while it starts the batch 
capture to make sure that it can grab onto your first timecode reference, 
and you should also check on the batch capture several times while it is 
running to make sure that it has not encountered any dropped frames, 
especially if it is a large batch.  If you experience a lot of timecode errors 
or dropped frames while batch capturing, try breaking up your batch 
capture into smaller batches, sorted by their Media Start timecode in the 
Browser window.  Another common capture error is caused by clip names 
that contain characters reserved for the system, so try renaming your clips 
without colons, semicolons or slashes.  Don’t forget to Save All both 
before and after you capture. 

2) You can log clips one by one, and use the Capture Clip button in the Log 
and Capture window to digitize each clip as soon as you set the out point. 

3) You can set an in point at the beginning of your tape (or your footage if 
your footage does not take up the entire tape) and an out point at the end 
of your tape/footage, and use Capture Clip to digitize the entire tape.  
Once your footage is digitized into Final Cut, you can play through the 
footage in the Viewer, set in and out points at the start and end of clips 
you want to create, and use the Modify-Make Subclip menu command to 
divide your footage into clips. 

4) You can use Capture Now to digitize footage without setting any in or out 
points.  This command will start capture from whatever point the tape is 
cued to when you press the Capture Now button, and will continue 
capturing until you hit escape or you reach your pre-set Capture Now limit 
(determined in your System Settings).  Not recommended unless you are 
digitizing from a non-controllable device. 

VERY IMPORTANT: When you’re capturing, make sure that you give each tape 
a unique Reel name.  DO NOT FORGET to change the reel name every time you 
start capturing from a new tape.  If you have timecode breaks on your tape, you 
need to give each segment of the tape a different reel name (for example, 
PortraitTape_2a, PortraitTape_2b, and so on) and make sure when batch 
capturing that you have manually cued the tape to the section that corresponds 
to the correct reel name referenced in the clips you want to capture.  Knowing the 
right reel name for each segment of footage is essential for Final Cut to be able 
to connect the correct media files to your project.  If you are not clear about 
naming your tapes, then it will create tremendous confusion in your project. 
 
STEP 4 
When you’re done capturing, close the Log & Capture window.  Your clips should 
now be listed by name in the Browser window, and you should be able to click on 
any clip to bring it up in the Viewer.  If any clip icons still have red slashes 
through them, the media (i.e. the video and/or audio) that they refer to was either 
not digitized or is not connected.  Try using File-Reconnect Media to find the 
media files.  If that doesn’t work, use File-Batch Capture to capture the clips, or 



re-open Log & Capture, drag & drop your clip into the window, and hit the 
Capture Clip button. 
 
Once your clips are all listed in the Browser, you can sort them using any of the 
characteristics displayed in the window (scroll to the right to see them all) by 
clicking on any of the columns (e.g. Name, Duration, Log Note, Media Start, etc.).  
An up arrow will sort in ascending order, a down arrow in descending order.  You 
can also drag the columns to the left or right to change which characteristics of 
the clips are visible in what order.  You can also use the menu command File-
New Bin (key command Command-B) to create folders into which clips can be 
organized. 
 
 
3.  EDITING IN THE TIMELINE, VIEWER AND CANVAS WITH INSERT, 
OVERWRITE, SPLICE AND TRIM 
 
Now that you’ve imported or digitized your media into your FCP project, you can 
actually begin editing.  You can use many of the same key commands to work 
with your clips in the Timeline, Viewer and Canvas that you used to work with 
your original footage in the Log & Capture window, including j, k, and l for reverse 
play, pause and forward play, and i and o for setting in and out points.  You can 
also use Shift-i and Shift-o to go to your in and out points and Option-i and 
Option-o to clear your in and out points.   Equivalent menu commands can be 
found under the Mark menu. 
 
The basic edit can really be reduced to a very simple equation: you have two 
clips; you want to join them together into a sequence; so you need to determine 
where each clip will start and end, and then determine where they will be 
juxtaposed.  Of course, while Final Cut gives you a graphical view of your clips 
and how they relate to each other, you’re really making decisions about their 
duration, so you’re really working with time, i.e. when each clip will start and end 
and when they will intersect.  The start and end of each clip are its in and out 
points.  When you join two clips in sequence, the out point of the first clip lines up 
with the in point of the second clip.  In linear editing, once your first clip is laid 
down into the sequence of the Timeline, the out point of that clip becomes the in 
point of the next clip you edit into the Timeline.  
 
In practice: to begin editing, you need to bring up the first clip you want to edit 
into your sequence into your Viewer window by double-clicking it in the Browser.  
Click into the Viewer window to activate it and then play through the clip using 
key commands or the window player controls.  Find the beginning of the footage 
you want to use, and set an in point.  Then find the end of the footage you want 
to use, and set an out point.  (If you want to use the whole clip, you can navigate 
to the beginning of the clip by using the home key and to the end of the clip by 
using the end key.)  Next, edit your selection into the Timeline with the Overwrite 
command (the red button on the Canvas window, or the key command 



Command-F10).  You should now be able to play your edited clip from both the 
Timeline and Canvas windows.  If instead of seeing the video you expect, you 
see a message that the media is unrendered, you may have imported media files 
with different settings from your project format.  You can use the Sequence-
Render-All menu command to render the media so that it is viewable within your 
project. 
 
If you’re satisfied with the in and out points you’ve set for your edited clip, set an 
in point at the end of the clip in the Timeline, and bring the next clip you want to 
work with up into the Viewer.  Set your in and out points and Overwrite the new 
clip into the Timeline after the first clip.  Next, go back and play through your 
sequence from the beginning.  Now, you need to judge not only the effectiveness 
of the in and out points for each clip individually, but also how they make the cut 
between the two clips work.  Should one clip start or end earlier?  If so, you have 
several options for changing the cut.   
 

1) You can use Trim.  Click into the Timeline and position the yellow cursor 
on the cut.  (You can use the semicolon and apostrophe keys to jump from 
cut to cut within your sequence.)  Then use the menu command 
Sequence-Trim Edit or the key command Command-7 to bring up the Trim 
window.  You can now use the –1, -5, +1 and +5 buttons on the Trim 
window, or the arrow keys on the keyboard, to add and subtract frames on 
either side of the cut.  Remember that if you have Dynamic Trimming 
enabled (either in the Trim Window or in your User Preferences), when 
you add frames on one side of a cut, the same number of frames will be 
subtracted on the other side.  After you adjust the cut, use the play arrow 
on the window or the space bar on the keyboard to preview the trimmed 
cut.  Once you’re satisfied, close the Trim Window by clicking elsewhere in 
the Timeline. 

2) If you play through your Timeline and find a segment of one clip that 
needs to be deleted, you can use the Splice tool in the Tool Palette 
window.  Set an out point in the Timeline where you want to cut and delete 
the segment.  Then move to the right of your Timeline window, where 
there should be a small palette with a choice of different tools.  (If you 
don’t see the palette, use the menu command Window-Tool Palette to 
bring it up.)  The default is the arrow.  Click onto the small razor blade.  
Then line the razor blade up with your in point and cut the clip.  (Note that 
unless video and audio are unlinked or separately locked, they will be cut 
simultaneously.)  Next, select the new segment and use the key command 
Shift-Delete to simultaneously delete the selected segment and close the 
gap.  If you want to leave the gap, just hit delete.  You can close the gap 
later using the menu command Sequence-Close Gap (Control-G), or you 
can use the arrow to grab the end of a clip and drag it out to fill the gap 
(thereby also increasing its duration). 



3) You can use the Roll and Ripple tools (both accessible under the vertical 
figure 8 in the Tool Palette) to shift a clip’s in and out points without 
changing its position in the Timeline.   

4) Similarly, you can double-click any clip in the Timeline to bring it up in the 
Viewer, where you can adjust its in and out points -- as long as your 
adjustments do not affect other clips in the Timeline.   

5) If you want to add another clip in between the two clips already edited into 
the sequence, you can perform an Insert edit.  Set in and out points in 
Viewer and Timeline as you would for an Overwrite, and then use the 
yellow button on the Canvas or the key command Command-F9 to Insert 
the clip between the other media before and after the in point set on the 
Timeline.    

 
Each time you edit another clip into the Timeline, it changes the progression, 
rhythm, movement and visual dynamic of the entire sequence, so it’s a common 
practice to re-view the sequence from the beginning (or from the beginning of a 
sub-sequence in longer works) in order to judge (and adjust for) the effectiveness 
of each edit.



4.  TRANSITIONS AND EFFECTS 
 
Video and audio transitions, generators and filters can be controlled in Final Cut 
from the Effects window (which should be set up by default as a tab in your 
Browser window; if not, you can open it from the menu Window-Effects) or by 
way of the Effects menu.  Motion effects are controlled through the Motion tab of 
each clip, and can be modified globally (by changing a master clip in the 
Browser) or locally (by changing an edited clip in the Timeline). 
 
TRANSITIONS 
Once you have mastered straight cuts, you may want to explore the use of 
transitions between clips -- although it’s a good idea to think seriously about 
whether you have a real reason to use a transition other than a cut before you 
apply one, since any other transition will always attract more attention to the edit 
than a cut would have.  Video transitions built into FCP include various kinds of 
dissolves, fades, wipes, peels, slides and zooms.  In practice, the most 
commonly used transitions are cross dissolves, dissolves to color (“flash 
frames”), and fades to and from black.  Audio transitions built into FCP include 
cross fades to +3 decibels and cross fades to 0 decibels. 
 
To add the default video transition (a cross dissolve) to a cut, position the cursor 
over the cut in the Timeline and use the key command Command-T.  To add the 
default audio transition (a cross fade), use the key command Option-Command-
T.  The transitions will be added at the default length that you set in the 
Transitions folder in the Effects window.  You can also drag and drop transitions 
(and other effects) from the effects window onto cuts in the Timeline.  If you use 
certain transitions frequently, it’s a good idea to copy them to your Favorites 
folder in the Effects window, so you can find them easily; you can even copy 
them several times and set several different favorite durations.  Once applied to 
the Timeline, you can change the length of any transition by double-clicking on it 
to bring up the transition window and/or using the Slip and Slide tools (the 
horizontal figure eight) from the Tool Palette. 
 
GENERATORS 
Video generators built into Final Cut allow you to create Text (including scrolling 
and crawling credits), Color Mattes, Shapes, Bars & Tone, and Noise, which can 
then be saved and edited as clips.  Generators can be accessed through the 
Effects window and also through the menu designated by the A surrounded by a 
square, located at the lower right corner of the Viewer window.   If you select 
Text-Crawling Text from the Generator menu, for example, the Text generator 
will open in the Viewer window.  You can click into the Control tab of the window 
to change the text, font, size, style, color, kerning, and leading, and the direction 
in which the text crawls.  Important: Once the text is set as you like it, you need 
to drag and drop the generator from the Viewer into the Browser, so that it is 
saved as a clip.  Rename the clip – generally the words of the text it contains 
make a useful name – and then double-click on the clip in the Browser to bring 



your renamed, saved clip up in the Viewer.  Then edit from your saved clip into 
the Timeline. 
 
MOTION EFFECTS & MULTIPLE TRACKS 
Motion effects are applied to your clips either locally (by double-clicking into a clip 
from the Timeline to bring it up in the Viewer) or globally (by double-clicking on a 
clip in the Browser to bring it up in the Viewer) through the Motion tab of the 
Viewer.  Locally applied effects will only affect the specific instance of the clip as 
edited into the timeline, while globally applied effects will affect every instance of 
the clip.  On this tab you can use sliders or type in numerical / percentage values 
to adjust various properties of the clip, including opacity, scale, position (by 
changing either the center or anchor points), rotation, distortion, cropping, and 
speed/duration (through variable or constant Time Remap).  Most of these 
properties can be keyframed, meaning that you can set different values at 
different points along the duration of the clip.   
 
For example, if you wanted to work with two superimposed layers of video, you 
would use the menu command Sequence-Insert Tracks to add a second video 
track (as well as additional audio tracks if necessary) to your sequence in the 
Timeline.  You would then edit your first layer into video track v1 using overwrite 
or insert as appropriate to the rest of your sequence.  Then you would move your 
cursor to the interlocking v1, a1, and a2 (and so on) track icons on the left side of 
the Timeline, and drag the source v1, a1 and a2 (or whatever combination of 
source tracks you have) from the tracks that are already full to the new, empty 
target tracks.  If you just want to use the source video but not the sound, or vice 
versa, then just double click the source track icon to separate it from its 
companion icon – otherwise it will automatically be edited along with the rest of 
the source media.  Once your tracks are aligned, then you can Overwrite your 
second clip into the second video track.  It’s generally not a good idea to use 
Insert with multiple tracks because it’s easy to throw edits out of alignment, and 
especially to throw video and audio out of sync, unless you are very careful. 
 
Once you have your two clips superimposed in two tracks, only the clip in track 
v2 will be visible unless you adjust the opacity of one or both of the clips.  To 
create a smoother transition from single-layer to multiple-layer video, one 
strategy is to keyframe the opacity.  This means that you would double-click into 
the superimposed clip in the v2 track of the Timeline, bring it up in the Viewer, 
click into the Motion tab, and open up the Opacity arrow.  Then you would use 
the <> button to set a keyframe at the first frame the clip and set the opacity for 
that frame at 0, using the slider.  Next you would set another keyframe about a 
quarter of the way into the clip, where you would set the opacity to the highest 
level that you want it to reach (typically 75-80%).  Set another keyframe at about 
three-quarters of the way through at the same opacity, and then set the final 
keyframe at the very end of the clip, back to 0. 
 
 



FILTERS 
Final Cut also has a number of filters that you can use to control, correct, and 
process your video and audio.  These are accessible through the Effects tab in 
the Video Filters and Audio Filters folders.  Here again it will be useful for you to 
copy your favorite filters into your Favorites folder rather than trying to find the 
same filter buried deep in a nested folder every time you need it. 
 
The most useful filters for basic editing are the Image Control video filters (e.g. 
Color Correction and Levels), which allow you to retouch the video image in a 
manner similar to, but somewhat cruder than, the Photoshop interface; and the 
Hum Remover (helpful for eliminating camera noise), 3-Way EQ and Low Pass 
audio filters, which mimic the functions of an analog mixer. 
 
KEEP IN MIND: Effects that are applied without reason detract from, rather than 
adding to, the effectiveness of a video. 
 
 
5.  EXPORT AND OUTPUT 
 
Once you’re finished editing, you will either need to output your final sequence to 
tape (usually your best option for archiving) and/or export your video to another 
format in order to upload it to the web, burn it to a data CD or DVD, or author it to 
a video DVD. 
 
EXPORTING VIDEO FOR DVD, MULTIMEDIA & THE WEB 
Within any project, you can export a sequence or section of a sequence from the 
Timeline/Canvas, or export a clip or section of a clip from the Viewer.  Start by 
setting in and out points at the beginning and end of the video you want to 
export.  The menu command File-Export then offers you three options for 
exporting your video: 
 
1. Export QuickTime Movie  
This option will create an FCP-formatted QuickTime video with the same settings 
(size and compression) as your project.  Since this type of QuickTime movie can 
only be opened/viewed in Final Cut Pro, this export option is most useful as a 
tool for mixing down sequences to import into other projects, or to re-import into 
the same project when you need to apply effects across an entire sequence. 
Update: Once the new helper apps are installed in the lab, you can use MPEG 
Streamclip to quickly convert an FCP-formatted QuickTime into a standard .mov, 
and you can also use ffmpegX to re-compress an FCP-formatted QuickTime 
directly, which can speed up your export/authoring workflow when time is an 
issue but media storage is not. 
 
2. Export Using QuickTime Conversion 
When you select File-Export-Export Using QuickTime Conversion, Final Cut 
opens up a Save As dialog box.  Within this dialog box, you can then use the 



Format pop-up menu at the bottom of the window to select your export format, 
which can be QuickTime (.mov), AVI, MPEG4, or MPEG2 video files, iPod 
movies, still images as PICT or TIFF files from any video frame, AIFF or WAV 
sound files, FLC (Flash compressed) video files, DV streams, or still image 
sequences.  Each format has its particular uses, contexts and drawbacks.  
MPEG2s and AIFFs are used for authoring video DVDs, while QuickTimes and 
MPEG4s are used for the web and multimedia applications.  AVI and WAV files 
will most often be used for transferring video from Mac to PC environments.  
Once you’ve selected the format, you can use the Use pop-up menu directly 
beneath the Format menu to choose between the default or several different pre-
set export settings.  You can also use the Options button to open up an Export 
Settings dialog box where you can change the settings manually.  You should 
refer to the Final Cut Pro manual for more detail on the settings for each format 
and how they can be changed to reduce file size or increase video quality.  
 
3. Export Using Compressor 
Compressor is FCP’s own helper application for exporting and re-compressing 
video and audio files.  You can use Compressor in tandem with FCP as an 
exporting tool, or you can launch it directly from the Applications folder to 
compress video and audio that has already been prepared as stand-alone files.  
The principal advantage of using Compressor is that the application structures 
compression into batches.  Within each batch, you can execute multiple 
compressions, either on the same source media file with different preset settings, 
or on multiple different source files.  To add a new compression to a batch, just 
click on the plus sign at the lower left corner of the Batch window.  You can then 
select what media file will be compressed by double-clicking in the Source Media 
field.  Next, choose the compression settings by opening up the Preset pop-up 
menu.  Compressor has pre-made presets for preparing video and audio as 
separate files for DVD authoring at different quality levels (under MPEG-2) and 
video/audio files for the web (under MPEG-4).  To create your own presets with 
customized settings, open up the Preset window by clicking on Preset or using 
the menu command Window-Preset.  You can then either click on the plus sign 
button to create a new preset, and edit it through the Encoder tab, or you can 
duplicate an existing preset with the page-plus sign button and adjust its settings 
to meet your needs.  Once you’re done, double click on the preset’s name in the 
Name column and give it a name, then a description, that fit the new settings you 
have created.  Back in the Batch window, you will also need to specify a 
Destination folder where your newly compressed file will be saved.  If you will be 
saving most files to the same place, it’s probably worthwhile to set that folder as 
a named and/or default destination in the Destinations window – again by using 
the plus sign button to create a new destination (local or remote).  Finally, it’s 
usually a good idea to also set the output filename for a compressed file in the 
Batch window; Compressor will automatically assign names that are quite long, 
since they include the source media file name and the compression preset. 
When you use the File-Export-Export Using Compressor menu command in Final 
Cut, FCP will launch Compressor and automatically open up a new Batch with 



your active sequence or clip listed as the source media.  All you need to do then 
is set the Preset, Destination, and Output Filename, and submit the batch. 
 
Other Export options include AIFF and OMF sound files for mixing in programs 
like Peak or ProTools, and EDL (edit decision lists) and Batch Lists in several 
different formats, which can be used to recreate an FCP project in a different 
editing program. 
 
 
OUTPUT TO TAPE 
 
BEFORE YOU START: Final Cut offers two options for outputting your final 
sequence to tape: File-Print to Video or File-Edit to Tape.  In order to use either 
option, your camera needs to be in playback mode, hooked up to the computer 
with a FireWire six-pin to eight-pin cable, and should mirror the video in your 
Canvas on its screen when you play through the Timeline.  This means that Final 
Cut needs to be reading your deck or camera as an external A/V device.  One 
way to check whether a device is initialized is through the menu command View-
External Video: if External Video is set to None, FCP is not reading your device.  
There are several ways to fix this problem.  First, try opening up your 
Audio/Video Settings (under the Preferences menu) and looking at the A/V 
Devices tab.  If you find your camera/deck listed there, or if you can locate it by 
clicking on the Options buttons, then you should be OK.  If that doesn’t work, 
save all your work, quit FCP, disconnect and reconnect your camera, and then 
restart your camera.  Finally, your camera may be in playback mode but need to 
be switched from Play to Record.  This can usually be done through the camera’s 
menu while the camera is in playback mode.  As usual, you should also make 
sure that you have activated the window corresponding to the sequence you 
want to output when you give FCP the output command. 
 
Edit to Tape performs a true assemble edit, whereby the in and out points set in 
your sequence are matched up to the corresponding timecode on the tape in 
your deck.  In order to use ETT, you need a deck or camera that can be device 
controlled by FCP, and a tape that has been blacked out (a tape with a 
blank/black video signal recorded from start to finish so that the tape has 
continuous timecode).  ETT is the preferred output system for archiving a 
project’s final form, since it maintains the timecode of a final sequence, in 
alignment with any EDLs or batch lists you may also archive in case you need to 
re-create the project later.  Update: please note that you can only use Print to 
Video to output HDV projects; Edit to Tape will not work with an HDV camera. 
 
Print to Video (Control-M) is the method you will be using most often to output 
rough sequences to tape to show in class, or to archive final cuts to tape when 
you are using a camera or deck without device control and/or a tape without pre-
recorded timecode.  With Print to Video, you should also set in and out points at 
the beginning and end of your sequence (or section of sequence), and select the 



option to Print In to Out in the Print to Video dialog box that opens up when you 
give FCP the Print to Video command.  You also have the option to insert bars 
and tone, a slate and black before your sequence, to loop your sequence, and to 
add a trailer of black after your sequence.  The standard is to output 30 seconds 
of bars and tone at –14 db as a reference, 30 seconds of black, the program, and 
then 60 seconds of black.  Since Print to Video does not control the external A/V 
device, you have to manually cue your tape before hitting the OK button to start 
printing.  You will then be prompted to start your recorder, at which point you 
need to hit record on your camera (this is sometimes a menu, not a button 
function) and hit OK again.  The video will then start playing back to your camera.  
When it’s done, Print to Video will automatically exit back to the normal FCP 
desktop, but you will need to manually stop the recording process on your 
camera. 
 
KEEP IN MIND: You should render all video and audio in your sequence before 
export or output.  If you experience dropped frames during ETT or PTV, open up 
your Audio/Video Settings, and look at the A/V devices.  Make sure that none of 
the audio playback options are set to Built-in Audio – since Mac’s built-in audio 
plays at 44.1 khz, and DV audio is 48 khz, the discrepancy can cause playback 
errors.  You can also try un-checking Mirror on desktop. 
 
 
 
6.  TROUBLESHOOTING 
 
One of the most important things to learn as an editor is how to solve problems 
independently as they come up.  Like any complex piece of software, FCP has its 
quirks and bugs, which change as new versions are released, upgraded, and 
adapted to particular environments.  Using Final Cut in a multi-user environment 
like the MAC lab also raises particular challenges.  So you should make a point 
of becoming familiar with the resources for troubleshooting both built into the 
program and available online.  First, through the Help menu, you can access the 
FCP manual, which is extensive, searchable, and also has an interactive index 
(click on any term in the index and the corresponding page will open).  A hard 
copy of the manual can also be checked out from the lab assistants.  Next, 
Apple’s online support features white papers and user forums that address late-
breaking and user-initiated topics (http://www.apple.com/support/finalcutpro/).  
Many other user forums and white papers on Final Cut are online as well, so 
often just searching for your question or bug on Google will yield the answers or 
documentation you need. 


